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Chapter 0 -  About this document

This document is the user manual for the Turn Node of Concept Systems Limited’s integrated navigation
system designed for marine geophysical survey usage (SPECTRA). SPECTRA is a modular system
comprising various Nodes.

This manual describes how to use the Turn Node.  Chapter 1 introduces the Node and explains how to get
started with it.  Chapter 2 describes how to establish a turning path, and Chapter 3 describes how to
configure the display.

For a general overview of the operation of SPECTRA and for a description of features and conventions
common to SPECTRA Nodes, see the SPECTRA User Manual - Beginners Guide. For a glossary of
terms, see the SPECTRA User Manual - Glossary.  For brief descriptions of each Node, detailed
descriptions of the options provided by other SPECTRA Nodes and details of how to start each Node, see
the Spectra Software Installation and Set Up manual.

Revision history

Document Reference Date Notes
SPCTRA_2.0/USER/TN/1.0 12th November 1996 First issue
SPCTRA_2.0/USER/TN/2.0 Operational flow diagram amended.
SPCTRA_2.5/USER/TN/2.5 13th February 1998 Operational flow diagram amended again.

Section added on Saving and Restoring
Turn Details from file.

SPCTRA_6.5/USER/TN/2.5 October 1998 Small correction
SPECTRA_7.6.7/USER/TN/3 December1999 Iconic buttons added to Turn Editor

Helmsman display

Document cross-reference

Document Reference Title
SPECTRA/INSTALL_2 Spectra Software Installation and Set Up
SPECTRA/USER/BEGIN SPECTRA User Manual - Beginner’s Guide
SPECTRA/USER/GLOSS SPECTRA User Manual - Glossary
SPECTRA/USER/DSN SPECTRA User Manual - Data Server Node
SPECTRA/USER/DTN SPECTRA User Manual - Data Transfer Node
SPECTRA/USER/DN SPECTRA User Manual - Display Node
SPECTRA/USER/LMN SPECTRA User Manual - Line Management Node

Conventions used in this document
The conventions used in this, and all other SPECTRA user manuals, are
those defined in the SPECTRA User Manual - Beginner’s Guide.
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Chapter 1 -  Introduction

This chapter describes some fundamental aspects of the Turn Node and explains how to get started with
it.

What is the Turn Node?
When steering the vessel to the next survey line, the navigator usually
has to negotiate a turn.  The Turn Node assists the navigator in this
aspect of steering.  An aimpoint (that point at which the vessel will be in
the correct position and orientation to approach the next survey line) is
defined via the LMN, and the navigator selects whether to base the turn
path on the current line or the vessel position.  Based on this exit point,
the TN then calculates and displays the optimum turning route to the
aimpoint.  The calculation takes into consideration the position and
orientation of the vessel at the start and end of the turn, and the distance
between these two points.

The turn will consist of two types of element:

Turning arcs the curved parts of the turn.  The turning path which the
vessel follows as it leaves the current line is known as
the Initial Arc; that which it follows as it sweeps onto
the aimpoint is the Final Arc.  The size and shape of
these arcs are based on circles or wheels, known as the
Initial Wheel and the Final Wheel respectively.  The
navigator may configure the radii of these wheels. In
some situations the computed turn may be based on more
than two wheels, in others the turn may consist of only
one wheel.  The wheels appear in the Turning Node’s
main display window.

Turn segment the straight-line path connecting two turning arcs.

The calculated turning path does not take account of any obstacles which
may lie along it.  However, the TN allows the navigator to manipulate
the route by adding turning wheels (and hence turn segments), adjusting
the wheel position and toggling the wheel sense - the direction, to port or
starboard, of the turn.

The following sketch illustrates some of the features of the TN’s main
display:
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Turn Node operational flow
The following diagram shows the process of using the Turn Node, and
the relationship between this process and the Node’s main windows.
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Getting started

Common features
Note that some features are common to all SPECTRA Nodes. These
include:

•  general use of the mouse buttons;

•  status areas on a node's main window;

•  opening and saving configuration files, and exiting from the node (via
the File menu on a node's main window);

•  submitting configuration changes to the Data Server (via the Submit
button or the File menu on a node's main window);

•  selecting or specifying a file (for opening or saving the
configuration);

•  connecting to and disconnecting from the Data Server, and viewing
communications errors (via the Communications menu);

•  applying any configuration changes to the Node and exiting from the
sub-window (via the OK, Apply and Cancel buttons or the File menu
on sub-windows of the node); and

•  obtaining help.

Starting the Turn Node
Normally, you will start the Turn Node from the Monitor Node. Details
of the commands needed to start this and other SPECTRA Nodes can be
found in the Spectra Software Installation and Set Up manual.
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The main window
The starting point for setting a turning path is the Turn Node window.

Displays a Change-Status
message when a turn path
is enabled or disabled.

Displays a Change-Status
message when the
geometry of the current
turn is changed.

From here you can gain access to the Turn Editor, from which to
establish the turn path.  You can also utilise options to configure the
Turn Node’s display.
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Chapter 2 -  Establishing the turning path

There are two aspects to establishing the turning path: setting the aimpoint (via the Line Management
Node), and configuring and enabling the turning path (via the Turn Node).

Setting the aimpoint (from the LMN)
From the Line Control window of the LMN, select an aimpoint; a feature
to which the vessel will steer.  Note however, the aimpoint you select
here is the desired destination of the vessel; the aimpoint which appears
on the display is the point from which the vessel will be able to approach
its destination in the correct orientation.

When you select a survey line as the aimpoint, the line azimuth
determines the direction from which the vessel will approach the line.  In
fact, the course made good of the vessel will attempt to follow the line
azimuth.  Occasionally, this will result in a turn of the wrong orientation:
the vessel will travel away from the survey line rather than along it as the
following diagram illustrates:

Current Line

V1

Next Line

Line Azimuth

Line Azimuth

LEGEND

 ⊕  Aimpoint as displayed
 V1 Vessel
                    Survey Line
                    Vessel Course
               Turn Segment

⊕

If the Turn Editor display is configured to show the feature defined as
the aimpoint, you will readily detect such an occurrence.

To rectify such a problem, choose Reverse Aimpoint from the Line
Control window.  This has the effect of reversing the orientation of the
turn.
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Configuring the turn path (from the TN)
From the Turn Node main window select Options|Turn Editor.  This
reveals the Turn Editor, a display similar in appearance to the Helmsman
display.  Right click anywhere on this display to reveal the Turn Editor
Control window.

From here you can establish and enable a turning path; see below for
details.  You can also configure the Turn Editor to display the survey as
you require, see Chapter 3 “Configuring the Turn Editor display”, for
details.

Select the point from which you wish the turn path to be calculated. This
can be either the current vessel position or the end of the current line.
Use the iconic toolbar button to select Compute Turn based on Vessel
Position or Compute Turn based on Current Line, as appropriate.

 Clicking this button bases the turn path calculation on the current
line.

 Clicking this button bases the turn path calculation on the vessel
position.

 Click this button to Undo your last editing action.
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Setting the turn radius
Set the minimum wheel radius for the turning wheels which comprise the
turn.

Click this button (Turn Defaults) to reveal:

Enter the minimum required wheel radius (metres) for turning wheels
and click OK.  This fixes the radii for the initial and final wheels and the
default radii for all turn wheels that are subsequently created. The radii
of added wheels may be altered later. See “Adjusting the turning radius”,
below.

With the turn path on display, manipulate it to produce the optimum
route. See “Modifying the turn path” for details.

Modifying the turn path
The calculated turning route does not take account of any obstacles
which may lie along its path. The navigator can modify the route to avoid
any such obstacles by adding one or more turning wheels, adjusting the
position of such, and specifying the turning sense - to port or starboard.

Note: For operations such as Add, Delete, Flip and Toggle Sense, there are
certain circumstances in which the operation may not succeed, leaving
the turn unaltered.  For example, if the application computes the optimal
turn to consist of three wheels, you may select the intermediate wheel
and request Delete.  This request will be ignored, however, leaving the
turn in the original state.
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Adding a turning wheel
Consider the example below.  A turning route is defined and displayed.
Note the well lying close to the calculated route.  To manoeuvre around
this obstacle, add a turning wheel and manipulate the turning route.

 select turn then click  or 

Activate the turning path by middle clicking in the initial turning wheel.
Its circumference will appear as a dotted line.

Use the Add Turn Wheel buttons (shown above) to add either a port
(anticlockwise) or starboard (clockwise) turn.

Position the cursor inside the added wheel and hold down the middle
mouse button.  Drag the wheel away from the obstacle, holding the
mouse button down whilst doing so.  The original route remains on the
display as a solid line; the new route appears as a dashed line until the
mouse is released.
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 Release Mouse →→→→ 

The turning path still requires modification, however.  On inspection you
will notice that the additional turning arc has a starboard sense and
encompasses almost the entire turning wheel. Following this path would
require the vessel to loop the loop, when the obvious course is to make a
turn to port. You can change the sense of the turn in two ways; Flip or
Toggle Sense of the wheel.

Toggle sense

Activate the added wheel by middle clicking in its centre.

 Click the Toggle Sense button. The position of the wheel remains
constant while the turn segments jump to touch the wheel at new
positions. The turning arc now has a port sense.

Flip

Activate the added wheel by middle clicking in its centre.

 Click on the Flip button. (This causes the wheel to be reflected
through the point where the adjacent turn segments would meet if
extrapolated.)  The wheel position jumps while the adjacent turn
segments remain constant.  The turning arc now has a port sense.
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Note that you can only manipulate the position and sense of added
wheels: the initial and final wheels may move and change sense, but this
is controlled by the application.

Adjusting the turning radius of added wheels
Added turning wheels will have the same radii as the initial and final
wheels as defined via the Turn Defaults Editor. To adjust the radius of an
added wheel:

Middle click inside the wheel to be altered.

 Click the Set Radius button and the following window will appear:

In the Turn Radius field enter the minimum radius (metres) required.

Click OK to apply the configuration and close the window. The added
wheel will shrink or expand as configured.

If you desire all added wheels to have the same radius, configure this
window in advance of adding turning wheels.

Note that the size of the initial and final wheels cannot be altered.

Deleting a turning wheel
Select the wheel to delete by middle clicking in its centre.

 Click the Delete Turn Wheel  button.  The wheel will vanish and the
adjacent wheels will link up.

Enabling the turn
Confirm the route by making the turn path available to the rest of
SPECTRA.  From the Turn Node main window select Options|Turn
Control and Enable the turn.
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Viewing the turning path (via the DN)
You can view the turn path via the Helmsman display in the Display
Node.  The Turn Node’s display is very similar to the Display Node’s
Helmsman display but as each is configured independently, the same
survey features may appear differently in each. However, the Turn Node
will always display the turning arc as part of the full turning wheel; the
Display Node only shows the actual arc within the route.

The Turn Node The Display Node

The turning arc

Saving and Restoring Turn Details
Full details of the currently defined turn can be saved in a .TN file using
File|Save.  A file can be re-loaded at any time using File|Open.  Files can
be loaded and submitted to the data server automatically at system start-
up time by using the –X command line option (see the Spectra Software
Installation and Set Up manual).  If no .TN file is found, the Turn Node
will attempt to load a back-up “current turn file”.  This .CTF file is
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managed by the node as a safety measure and does not require any user
action.

WARNING! When the TN is closed down, or in the event of a crash, it saves the
current turn status to .TN and .CTF files.  On re-starting the node, that
turn will be automatically enabled.  If this is not appropriate at the time
of re-starting the node then you should immediately disable the turn via
the turn control window.

If the name of the working .TN file is changed during a run and a
crash/forced re-start occurs, the node will revert to the filename given by
the –X option in the mn.ini file or command line.

.TN and .CTF files are stored by default in the PN_DATA directory.
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Chapter 3 -  Configuring the Turn Editor
display

Like the Helmsman Display, the Turn Editor display can be configured in terms of scale, position, colours
used, and features displayed.

Choosing a colour for the turn
Choose a colour in which to display the turn. Select Display Options
from the Edit Turn options list to reveal the Turn Editor:

Right click on the Colour field to reveal a list of possible colours to
choose from. Select a colour and press OK. The chosen colour will
appear in the Colour field. Press OK to apply this colour to the display
and close the window. The default colour is yellow.

Displaying geographical coordinates
First select the format in which to display geographical coordinates.
Select Options|Defaults from the Turn Node main window to reveal the
Default Editor window:

Choose from DDMMSSsss (degrees, minutes, seconds and decimal
seconds), DDMMmmmmm (degrees, minutes and decimal minutes) and
DDddddddd (degrees and decimal degrees).
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Configuring the display features
Select Helmsman Control from the Edit Turn options list to reveal:

The Turn Editor control window is similar to the Helmsman control
window. Note however, the Options menu here is more limited.

Configure the display in the same manner as for the Helmsman display -
see the SPECTRA User Manual - Display Node for details. Note that for
the purposes of displaying the Aimpoint, it can be found at the bottom of
the list of Obstacles.
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